
fkdñf,a fnÞyeÍu i|yd h' 1

fuu mdvu yeoEÍfuka Tng"

  Ø    mß.Kl NdIdjkays mßKduh

Ø mß.Kl wkqidrfhka .eg¨ úi£u

Ø we,af.dß;u ksrEmKh

  Ø    úIqj,a fíisla Ndú;fhka jevigyka iïmdokh lsÍu

   ms<sn| j ukd wjfndaOhla ,nd .ekSug yels jkq we;'

mß.Klh wmg ke;s j u neß fuj,ula fjñka mj;S' mß.Kl

wkqidrfhka l< yels ld¾hhka rdYshls' fuu mßÉfþofha § wmf.a wjOdkh

fhduqjkafka .eg¨ úi£u i|yd mß.Klh fuj,ula f,i Ndú; l< yels

wdldrhhs'

mß.Klh wkqidrfhka .eg¨jla úi£fï § .eg¨j úi¢h hq;= wdldrh

mß.Klhg f;areï .; yels NdIdjlska" úOdk iuQyhl tl;=jla f,i

mß.Kl.; l< hq;= fõ' fujeks mß.Klhlg Rcq j u f;areï .; yels NdId

zhka;% NdIdZ (Machine Languages) f,i ye¢kafjhs' idudkHfhka hka;% NdIdj,

wvx.= úOdk yd tu úOdkj, iajrEmh mß.Klfha ilikfha ̂Processor& j¾.h

u; r|d mj;S' tkï úúO j¾.j, ilikhkag f;areï .; yels NdIdjkays

iajrEmh tlsfklg fjkia fjhs'

WodyrKhla f,i 'Intel' mjqf,a ilikhka i|yd ks¾udKh lr we;s hka;%

NdId 'SPARC' mjqf,a ilikhkaf.a hka;% NdIdj,g jvd fjkia fjhs' tkuq;a

fndfyda ÿrg iudk jQ hka;% NdId l%shdlrùu i|yd ks¾udKh jQ úúO ilik

j¾. o wo fjf<|fmdf<a olakg ,efí' WÞyrKhla f,i 'Pentium' iy 'AMD'

ilik j¾. ±laúh yels h'
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úúO ilik j¾. i|yd úúO hka;% NdId y÷kajd § we;;a tA ish¨ u

hka;% NdIdj,g fmdÿ jQ tla iqúfYAI ,laIKhla we;' tkï ish¨ u hka;%

NdIdj, ish¨ úOdk 0 yd 1 hk ixfla;hkaf.ka muKla iukaú; ùu hs'

mß.Kl jeks bf,lafg%dksl hka;%j,g ixfla; follg muKla iSud jQ oaúuh

NdIdjka ^Binary Language& f;areï .ekSug yels ùu fuhg uQ,sl fya;=j f,i

±laúh yels h' fujeks oaúuh fla;hka u; mokï jQ mß.Kl NdId my<

uÜgfï NdId (Low Level Languages) f,i o ye¢kafjhs'

fujeks my< uÜgfï NdId wmg tÈfkÞ mß.Kl l%shd lrùu i|yd
Ndú;hg b;d wiSre kuq;a mß.Klhg Rcq j u f;areï .; yels ld¾hlaIu
NdId úfYaIhla f,i ye¢kaúh yels h' fuu fya;=j ksid hka;% NdId  ke;fyd;a
my< uÜgfï NdId" mß.Klhg b;d ióm" ñksidg ÿria mß.Kl NdId úfYAIhla
f,i i,lkq ,efí'

hka;% NdId Ndú; lr úOdk §u b;d wiSre neúka" fï i|yd wmg ióm"
myiqfjka yeisrúh yels mß.Kl NdId úYd, ixLHdjla ks¾udKh lr we;'
fuu NdId by< uÜgfï mß.Kl NdId (High Level Languages) f,i ye¢kafjhs'
C, 'VB',  yd 'PHP' fï i|yd ksoiqka lsysmhls'

lsis hï ld¾hhla mß.Klfhka lr .ekSu i|yd mß.Kl NdIdjla
wkqidrfhka f.dkq l< Wmfoia ud,djla mß.Kl l%u f,aLhla (Computer

Programme) f,i ye¢kafjhs' fuu m%ldYhkaf.ka iuyrla l%shdlrúh yels
úOdk jk w;r wfkla m%ldY úOdkhka fkd fõ' fujeks úOdkhka fkdjk
m%ldYk u.ska l%uf,aL myiqfjka f;areï .ekSug wjYH f;dr;=re ^WÞyrK (-
újrK Comments& fuka u l%uf,aLhla hka;% NdIdjlg mßj¾;kh lsÍug
wjYH f;dr;=re imhd fokq ,nhs' fujeks úOdk fkdjk m%ldYkhka ms<sn|
uQ,sl ye¢kaùula miq j olajd we;'

C, VB, PHP jeks mß.Kl NdId wmg myiqfjka f;areï .; yels jqj;a
fuu NdId Rcq j u mß.Klhkag f;areï .; fkd yels h' tneúka fuu by<
uÜgfï NdId u.ska ;ekQ l%u f,aLhka mß.Klh l%shdlrùug fmr mß.Klhg
f;areï .; yels my< uÜgfï NdIdjlg mßj¾;kh l< hq;= fjhs' fuu l%shdj,sh
NdId mßj¾;kh (Language translation) fyda iïmdokh (Compilation) f,i
ye¢kafjk w;r fï i|yd .; yels úúO l%ufõohka miq j i,ld nef,a'

                 1'1   mß.Kl NdIdjkaf.a mßKduh            1'1   mß.Kl NdIdjkaf.a mßKduh            1'1   mß.Kl NdIdjkaf.a mßKduh            1'1   mß.Kl NdIdjkaf.a mßKduh            1'1   mß.Kl NdIdjkaf.a mßKduh

wdrïNfha isg wo olajd ìysù we;s ish¨ u mß.Kl NdIdjka tAjdfha
úOdkhkaf.a iajrEmh wkqj m%Odk ldKav y;rlg j¾. l< yels h'
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1' m<uq jk mrïmrdfõ mß.Kl NdId fyda

hka;% NdId (Machine Languages)

2' fojk mrïmrdfõ mß.Kl NdId fyda

tfiïí,s NdId (Assembly Languages)

3' ;=ka jk mrïmrdfõ mß.Kl NdId fyda

by< uÜgfï NdId (High Level Languages)

4' y;r jk mrïmrdfõ mß.Kl NdId fyda

ks¾udms; NdId (Artificial Languages)

mß.Kl NdIdjkaf.a úldYkfha § ±lsh yels uQ,sl ,laIKhla jkafka
tu NdId l%ufhka wmg myiqfjka f;areï .; yels iy Ndú;hg myiq NdId

f,i úldYkh ùuhs'

     m<uq mrïmrdfõ mß.Kl NdId

ish¨ u hka;% NdId fuu j¾.hg wh;a fjhs'

fuu NdIdjkag fmdÿ ,laIK

v ish¨ úOdk 0 yd 1 hk oaúuh fla; Ndú;fhka m%ldY l< hq;=hs'

v jevigyka iïmdokh yd úOdk mß.Klhg we;=<;a lsÍu b;d u ixlS¾K

ld¾hhls'

v hka;%fha j¾.h u; hefmk NdIdjls' tkï tla j¾.hl ilik i|yd

iïmdokh l< l%uf,aLhka fjk;a ilik j¾.hla u; l%shd;aul l<

fkdyels h'

v mß.Klfha úúO oDVdx. ms<sn| fyd| ±kSula ;sìh hq;= h'

 fojk mrïmrdfõ mß.Kl NdId

fuu j¾.fha NdId 0 yd 1 hk oaúuh ixfla; muKla Ndú;fhka l%uf,aL

f.dvke.Sug we;s wmyiq;dj uÕyeÍu i|yd ìysjQ NdId úfYAIhls'
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fuu j¾.fha NdIdjkag fmdÿ ,laIK #

v úOdk 'ADD', 'SUB' jeks ir, ixfla; kduhka u.ska ±laùu'

v ir, ixfla; kdu Ndú;fhka mß.Kl u;lfha o;a; .nvd lsÍug yd
kej; ,nd.ekSug yels ùu'

v l%uf,aLhka ksfÞia lsÍu ^Debugging& hka;% NdId l%uf,aL ksfÞia lsÍug
jvd myiq ùu'

v hka;% u; hefmk NdIdjka ùu'

v l%uf,aL ,sùu i|yd oDVdx. ms<sn| fyd| ±kqula wjYH ùu

fuu j¾.fha NdIdjkaf.ka iïmdÈ; l%uf,aL mß.Klhkg Rcq j u

l%shdlrùug fkd yels h' tA i|yd 'Assembler' kï jQ NdId mßj¾;lh u.ska tu

l%uf,aL fyda úOdk wÞ< hka;% NdIdjg mßj¾;kh l< hq;= fjhs'

     ;=ka jk mrïmrdfõ mß.Kl NdId

j¾;udkfha Ndú; jk C, VB jeks mß.Kl NdId fï .Khg wh;a fjhs'

fuu NdIdjkaf.a uQ,sl ,laIK (

v bx.%Sis jeks wmg ióm NdIdjka u; mokï ù ;sîu'

v hka;% u; hefmk NdIdjka fkdùu'

v l%uf,aL ,sùug yd tAjd ksfÞia lsÍug myiq ùu'

fuu NdId o tfiïí,s NdId fuka u mß.Klhkg Rcq j u f;areï

.ekSug fkd yels h' tneúka NdId mßj¾;l uDÿldx.hla u.ska fuu NdIdjkaf.ka

,shejqKq l%uf,aL wÞ< mß.Klfha hka;% NdIdj,g mßj¾;kh l< hq;= h'

y;r jk mrïmrdfõ mß.Kl NdId

fndfyda wjia:d j,§ y;r jk mrïmrdfõ mß.Kl NdId oDIH mßiaÓ;shla

^Visual Environment& ,nd foñka b;d myiqfjka mß.Kl jev igyka ilia

lsÍug wjia:dj ,nd foa'

fuu j¾.fha NdIdjkaf.a uQ,sl ,laIK #

v bx.%Sis jeks udkj NdIdjkag b;d ióm ùu'

v flá ld,hlska bf.k .ekSug yels ùu'
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v wjYH lrk úOdkhka ;=kajeks mrïmrdfõ mß.Kl NdId j,g

jvd wvq úOdk ixLHdjlska lr .ekSug yels ùu'

^1& hka;% NdId yd tfiïí,s NdId w;r we;s uQ,sl fjkialï

,ehsia;=.; lrkak'

^2& tfiïí,s NdId yd by< uÜgfï NdId w;r we;s uQ,sl

fjkialï ,ehsia;=.; lrkak'

                 mß.Kl NdId mßj¾;khmß.Kl NdId mßj¾;khmß.Kl NdId mßj¾;khmß.Kl NdId mßj¾;khmß.Kl NdId mßj¾;kh ^̂̂̂̂Programming Language Translation&&&&&

mß.Klhg Rcq j u l%shdlrùug yelsjkafka 0 yd 1 hk oaúuh fla;hka

u; mokï jQ hdka;%sl NdIdjla muKla nj wms y÷kd .;suq' tneúka hdka;%sl

fkdjk tfiïí,s jeks fojk yd ;=ka jk mrïmrdfõ NdIdjkaf.ka ,shjqKq

l%uf,aL fyda úOdk mß.Klhla ;=< l%shd;aul lsÍug fmr mß.Klhg f;areï

.; yels hdka;%sl NdIdj njg mßj¾;kh l< hq;= h' fufia tla mß.Kl

NdIdjla ;j;a NdIdjlg mßj¾;kh lsÍfï l%shdj mß.Kl NdId mßj¾;kh

(Translation) f,i ye¢kafjhs' fuu ld¾hh i|yd Ndú; l< yels m%Odk l%ufõo

;=kls'

^1& tfiïí,r (Assemblers) Ndú;h

^2& iïmdol (Compilers) Ndú;h

^3& w¾: úkHdil (Interpriters)

   tfiïí,r   tfiïí,r   tfiïí,r   tfiïí,r   tfiïí,r (Assembler)

Assembly NdIdfjka ilia lrk ,o mß.Kl jevigykla mß.Klhg

f;areï.; yels hdka;%sl NdIdfõ (Machine Language) fla; njg mßj¾;kh

lrk jevigykls'

   iïmdoliïmdoliïmdoliïmdoliïmdol (Compilers)

iïmdol j¾.fha uDÿldx. u.ska l%uf,aLh mß.Klhg myiqfjka f;areï

f.k ls%hd;aul l< yels jia;= fla; f.dkqjla (Object Code) njg m;a lsÍu isÿ

lrhs' fufia l%uf,aLh hdka;%sl NdIdjg yerjQ miq tu hdka;%sl NdIdfjka jQ

l%uf,aLh mß.Klh ;=< l%shd;aul fõ' C, FORTRAN mß.Kl NdId iïmdol

fï i|yd ksoiqka lsysmhls'
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iïmdol u.ska NdId mßj¾;kfha § mßj¾;kh i|yd fhdÞ.kakd

uq,a l%uf,aLh m%Nj fla; l%uf,aLh (Source Code Program) f,i o mßj¾;kfhka

miq ,nd.kakd l%uf,aLh jia;= fla; l%uf,aLh (Object Code Program) f,i o

ye¢kafjhs' NdId iïmdolhla u.ska isÿjk m%Odk l%shdj,sh jkafka m%Nj l%uf,aLh

úIh l%uf,aLhg mßj¾;kh lsÍuhs' NdId mßj¾;k l%shdj,sfha § mß.Kl

mßj¾;lhd (Language Translator) isÿlrk ;j;a m%Odk ld¾hhla kï m%Nj

l%uf,aLfhys we;s jerÈ y÷kd .ekSuhs' je/È iys; l%uf,aL mßj¾;lhka u.ska

úIh l%uf,aLkhkg mßj¾;kh l< fkd yels h' tneúka l%uf,aLkhka f.a

we;s ish¨ jerÈ y÷kd .ekSu yd ksfÞia lsÍu fuu l%shdj,sfha § isÿ l< hq;= h'

fufia l%uf,aLhka f.a we;s je/È y÷kd .ekSu iy tu je/È ksfÞia lsÍfï

l%shdj,sh 'Debugging' f,i o l%uf,aLhka f.a we;s je/È 'Bugs' f,i o ye¢kafjhs'

  w¾: úkHdilw¾: úkHdilw¾: úkHdilw¾: úkHdilw¾: úkHdil (Interpreters)

w¾: úkHdil uDÿldx. u.ska uq¿ l%uf,aLh u tl jr hdka;%sl NdIdjlg

mßj¾;kh lsÍu isÿ fkd fõ' fuys § isÿjkafka l%uf,aLfha wka;¾.; úOdk

tlsfkl l%shd;aul lsÍfï wjia:dfõ § u wÞ< hdka;%sl NdId úOdk iuQyhlg

mßj¾;kh lsÍuhs' fuys m%;sM,h jkafka fuu j¾.fha l%uf,aLhla l%shd lrjk

iEu wjia:djl § u fuu mßj¾;k l%shdj,sh kej; kej; isÿ lsÍug wjYH

ùuhs' tneúka idudkHfhka fuu j¾.fha l%uf,aLhla l%shd lsÍug .kakd

ld,h iïmdokh l< l%uf,aLhg .kakd ld,hg jvd jeä fjhs' VB, Python

fuu j¾.hg wh;a mß.Kl NdId fjhs'

           1'2  mß.Kl wkqidrfhka .eg¨ úi£fï wÈhr          1'2  mß.Kl wkqidrfhka .eg¨ úi£fï wÈhr          1'2  mß.Kl wkqidrfhka .eg¨ úi£fï wÈhr          1'2  mß.Kl wkqidrfhka .eg¨ úi£fï wÈhr          1'2  mß.Kl wkqidrfhka .eg¨ úi£fï wÈhr

.eg¨ úi£u i|yd mß.Kl Ndú; lsÍfï § wkq.ukh l< hq;= wÈhr lsysmhls'

1& .eg¨j úYaf,aIKh lsÍu'

2& .eg¨j úi£u i|yd iqÿiq we,af.dß;uhla f.dvke.Su'

3& f.dvke.= we,af.dß;uh mß.Kl l%uf,aLhlg mßj¾;kh lsÍu'

4& l%uf,aLfha we;s je/È y÷kd .ekSu iy ksfÞia lsÍu'

5& l%uf,aL wÞ< o;a; u; l%shd;aul lsÍu'
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   1& .eg¨ úYaf,aIKh

.eg¨ úYaf,aIKfha uQ,sl mrud¾:h jkafka

1' wdÞk (Inputs)

2' m%;sÞk (Outputs)

3' wdÞk m%;sÞk njg mßj¾;kh lsÍfï ls%hdj,sh (Processing) y÷kd .ekSuhs'

WÞyrKh # iDcqfldaKdi%hl j¾.M,h fiùug wjYH hehs is;kak' fuu

ld¾hh i|yd wÞ< wdÞk" m%;sÞk yd l%shdj,Ska my; ±lafjhs'

wdÞk # iDcqfldaKdi%fha È. yd m<,

l%shdj,sh # È. x m<,

m%;sÞk # by; l%shdj,sfhka ,nd.;a m%;sM,h

    2&  .eg¨ úi£u i|yd we,af.dß;u f.dvkeÕSu

hï .eg¨jla úi£u i|yd wkq.ukh l< hq;= mshjr ish,a, wkqms<sfj<ska

±lajQ l%ufõohla we,af.dß;uhla f,i w¾: ±lafjhs'

by;ska ±lajQ WÞyrKh i|yd my; we,af.dß;uh f.dvkeÕsh yels h'

• iDcqfldaKdi%fha È. ,nd .ekSu'

• iDcqfldaKdi%fha m<, ,nd .ekSu'

• j¾.M,h = È. x m<,'

• j¾.M,h m%ldY lsÍu'

    3&  we,af.dß;u l%uf,aLhkag mßj¾;kh lsÍu

mß.Kl wkqidrfhka .eg¨ úi£fï § .eg¨j úi£u i|yd f.dvke.+

we,af.dß;u b;d ksje/È j" mß.Klhg f;areï .; yels NdIdjlska mß.Kl.;

l< hq;= fjhs' j¾;udkfha fï i|yd ks¾udKh jQ mß.Kl NdId b;d úYd,
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ixLHdjla we;' fï ish¨ u NdId mß.Kl wkqidrfhka .eg¨ úi£u i|yd

ilia jQ lD;%su NdId jYfhka ye¢kafjhs' C, Phython, Php, VB, FORTRAN fï

i|yd WÞyrK lsysmhls' we,af.dß;uhla mß.Kl NdIdjla u.ska ,shejqKq

l%uf,aLhlg mßj¾;kh lsÍfï l%shdj fla;kh (Coding) f,i ye¢kafjhs' fuu

ld¾hh lrkakd l%uf,aLlfhl= (Programmer / Coder) f,i ye¢kafjhs'

    4&  l%uf,aL ksfÞia lsÍu

fuys § l%uf,aLhka f.a we;s jerÈ y÷kd.ekSu iy tu jerÈ ksfÞia lsÍu

isÿ fjhs' fuu l%shdj,sh ksfÞia lsÍfï ls%hdj,sh (Debugging) f,i ye¢kafjhs'

bka wk;=rej o;a; idïm, wdÞkh lr wÞ< m%;sÞk ,efí ±hs mÍlaId lr n,kq

,efí'

    5&  l%uf,aL l%shd;aul lsÍu

fuys § ksfÞia l< l%uf,aL i;H wdÞk u; l%shdlr m%;sÞk ,nd.kq ,efí'

jD;a;hl j¾.M,h fiùu i|yd l%uf,aLhla f.dvke.Sug

wjYH jk wdÞk l%shdj,sh yd m%;sÞk y÷kd.kak'

Tn wjidk jdr úNd.fha § ish¨ úIhhka i|yd ,nd .;a

,l=Kqj, uq¿ tl;=j iy idudkH w.h ,nd.ekSu i|yd

l%uf,aLhla f.dvkeÕSfï § wjYH jk wdÞk l%shdj,sh iy

m%;sÞkhka y÷kd.kak'

                      1'31'31'31'31'3  we,af.dß;u ksrEmKh  we,af.dß;u ksrEmKh  we,af.dß;u ksrEmKh  we,af.dß;u ksrEmKh  we,af.dß;u ksrEmKh

.eg¨ úi£u i|yd we,af.dß;u f.dvkeÕSfï § wÞ< úOdk yd tu

úOdk l%shd l< hq;= wkqms<sfj< meyeÈ,s j ±laùu i|yd lsishï Ys,amSh l%uhla
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wjYH fjhs' fuu ld¾hh i|yd rEmuh (Graphical) fyda ,sÅ; (Textual) ksrEmK

Wmfhda.S lr.; yels h' .e,Sï igyka (Flowcharts) fï i|yd nyq, j Ndú; jk

rEmuh ksrEmKhla jk w;r jHdc fla; (Pseudo code) u.ska we,af.dß;u ,sÅ;

j ksrEmKh l< yels h'

              .e,Sï igyka .e,Sï igyka .e,Sï igyka .e,Sï igyka .e,Sï igyka (Flowcharts)

we,af.dß;uhl úOdkhka l%shd l< hq;= wdldrh wkqms<sfj<ska" rEmuh

ixfla; u.ska ±lajQ igykla .e,Sï igykla f,i ye¢kafjhs' .e,Sï igyka

ks¾udKfha § Ndú; l< hq;= iïu; ixfla; y÷kajd § we;' fuu ixfla;hka

f.ka nyq, j Ndú; jk ixfla; lsysmhla yd tu ixfla;hka f.a Ndú;h my;

j.=fjys olajd we;'

        ixfla;h  kduh              Ndú;h

Terminator wdrïNh $ wjidkh  (Start / Stop)

Process                úOdkhla fyda wkqms<sfj<ska l%shd l<
hq;= úOdk tl;=jla

                        Data Input / Output o;a; wdÞk $ m%;sÞk

Decision ;SrK

Connector iïnkaOl

Flow Lines o;a; .e,Sfï ÈYdjkaÚ

Ú

Ú

Ú
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WÞyrK # iDcqfldaKdi%hl j¾.M,h ,nd.ekSu i|yd f.dvke.+ .e,Sï

igykla my; ±lafõ'

.e,Sï igyka msgq lsysmhla yryd úys§ hk wjia:djkays § yd .e,Sfï

ÈYdjka flá f¾Ld LKavhka u.ska meyeÈ,s j ±laùu i|yd 'Connector' ixfla;h

fhdÞ .efka'

wdrïNh

i

i

È. iy m<, ,nd .ekSu

j¾.M,h .Kkh lsÍu

i
j¾.M,h m%;sÞkh lsÍu

i
wjidkh
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WÞyrK # § we;s ixLHd lsysmhl tl;=j fiùu i|yd wkq.ukh l< hq;=

l%shdÞuh .e,Sï igykla u.ska olajkak'

               jHdc fla;jHdc fla;jHdc fla;jHdc fla;jHdc fla; (Pseudo codes)

we,af.dß;uhka mß.Kl NdIdjla u; fkdhefmk NdIdjlska

(Pseudo code)  ir, j ±laúh yels h' fufia ±laùu i|yd Ndú; l< hq;= NdIdjka

yd tu NdIdjkaf.a wka;¾.;hka i|yd iïu; iïuq;shla fkdue;' tneúka

we,af.dß;uhla jHdc fla; u.ska ksrEmKh lsÍfï §" tu ksrEmKh l%uf,aLlhl=

fkdjk whl=g o jegfyk f,i ir, j m%ldY lsÍug j.n,d .; hq;= h'

i
tl;=j m%;sÞkh

lsÍu

i
    wjidkh

1i
    wdrïNh

i

tl;=j } 0

i

i

 Tõ

i

   ke;

tl;=j } tl;=j + X

ixLHdj ,nd .kak (X)

i
ixLHd

;j;a

;sfí o@

1
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12345678901234567890123456789012123456789012345678901234567890121
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by; WÞyrKfhka ±lajQ .e,Sï igyk ixLHd lsysmhl tl;=j

fuka u idudkH w.h o .Kkh lsÍu i|yd §¾> lrkak'
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WÞyrK #  iDcqfldaKdi%hl j¾.M,h fiùfï l%shdj,sh my; ±lafjk f,i

    jHdc fla;hlska ±laúh yels h'

wdrïNh

iDcqfldaKdi%fha È. yd m<, ,nd .kak

j¾.M,h = È. Í m<,

j¾.M,h m%;sÞkh lrkak

wjidkh

1'41'41'41'41'4 úIqj,a fíislaúIqj,a fíislaúIqj,a fíislaúIqj,a fíislaúIqj,a fíisla (Visual Basic)  Ndú;fhka Ndú;fhka Ndú;fhka Ndú;fhka Ndú;fhka

jevigyka iïmdokh lsÍujevigyka iïmdokh lsÍujevigyka iïmdokh lsÍujevigyka iïmdokh lsÍujevigyka iïmdokh lsÍu

    fuu fldgfia § .eg¨ úi£u i|yd úIqj,a fíisla (Microsoft Visual Basic

6.0) mß.Kl NdIdj Wmfhda.s lr jevigyka ilid .kakd whqre i,ld nef,a'

              úIqj,a fíislaúIqj,a fíislaúIqj,a fíislaúIqj,a fíislaúIqj,a fíisla

'Visual Basic' fyda 'VB' hkq ;=ka jk mrïmrdjg wh;a mß.Kl NdIdjls'

'VB' NdIdj m%Odk f,i úkafvdaia fufyhqï moaO;sh u; l%shdlrùu i|yd

ks¾udKh lr we;s mß.Kl NdIdjls' tneúka 'VB' j,ska ,shjqKq l%uf,aLhka

'Linux' jeks fufyhqï moaO;s u; l%shdlrùug fkd yels h' fuh 'VB' NdIdfõ

uQ,sl wvqmdvqjla f,i ±laúh yels h'

'VB' mß.Kl NdIdfjka l%uf,aL ilialr .ekSu i|yd wkq.ukh l<

hq;= l%shdj,sh iuyr mß.Kl NdIdjkaf.ka l%uf,aL ilialr .ekSfï l%shdj,shg

jvd ;rula fjkia fjhs' fuhg uQ,sl fya;=j 'VB' NdIdj jevigyka iïmdol

fuj,ula yd wkqnoaO lr ;sîuhs' fujeks jevigyka iïmdol fuj,ï

'Integrated Develpoment Environments' (IDE) f,i ye¢kafjhs' fujeks jevigyka

iïmdol fuj,ïj, m%Odk ld¾hh jkafka l%uf,aL myiqfjka f.dvkeÕSu

i|yd myiq miqìula ks¾udKh lr§uhs' tu.ska mß.Kl NdIdjka ms<sn| ukd

±kqula fkdue;s j jqj o ir, jevigyka f.dvkÕd .ekSug wjYH myiq

miqìula ,ndfohs' tneúka 'VB' Ndú; lr l%uf,aL ,sùu i|yd 'VB' yd wkqnoaê;

'IDE' .ek ukd ±kqula ,nd.ekSu w;HjYH lreKls'
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        úIqj,a fíisla jevigyka iïmdolúIqj,a fíisla jevigyka iïmdolúIqj,a fíisla jevigyka iïmdolúIqj,a fíisla jevigyka iïmdolúIqj,a fíisla jevigyka iïmdol IDE uqyqK;lg msúiSuuqyqK;lg msúiSuuqyqK;lg msúiSuuqyqK;lg msúiSuuqyqK;lg msúiSu'

'VB' jevigykla iïmdokh lsÍu i|yd wÞ< 'IDE' uqyqK;lg msúiSu

my; ±lafjk úOdkhka l%shd;aul lsÍfuka l< yels h'

1) Start

2) All Programs

3) Visual Studio 6.0

4) Microsoft Visual Basic 6.0

by; úOdk l%shd;aul lsÍfuka miqj my; ±lafjk mßÈ uqyqK;la ;srh

u; Èiafjhs'

úIqj,a fíisla 'IDE' u.ska úúO wdldrfha jevigyka iïmdokh l<

yels h' fujeks úúO wdldrfha jevigyka iïmdokh lsÍfï § l%shdlrúh hq;=

úOdkhkag wÞ< whslkhka (Icons) fuu ;srfha Èiafjhs' wmf.a wjOdkh fuys

§ fhduqjkafka Standard. EXE j¾.fha jevigyka i|yd neúka" Standard. EXE

whslkh la,sla lsÍfuka thg wÞ< uqyqK;lg msúish yels h' fujeks uqyqK;la

my; rEmfhka ±lafjhs'

rEmh 1'1
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1' fmdaru ie,iqï ljq¿j (Form Design Window)

2' jHdmD;s .fõIK ljq¿j (Project Explorer Window)

3' .=Kdx. ljq¿j (Properties Window )

4' fuj,ï fmÜáh (Tool Box)

5' fmdaru msßie,iqï ljq¿j (Form Layout Window)

6' m%Odk fukqj (Main Menu)

ie,lsh hq;=hs # Tnf.a mß.Klfha ia:dms; lr we;s  jevigyka wkqj l%shd;aul

l< hq;= úOdkhka iy tu úOdkhka l%shd;aul l< hq;= wdldrh

fjkia úh yels h'

'VB' jevigykla iïmdokh lsÍug wjYH ish¨ fuj,ï by; jevigyka

iïmdol 'IDE' uqyqKf;ys wvx.= fjhs'

'VB' jevigykla úúO wdldrfha f.dkq lsysmhlska iukaú; úh yels h'

fufia lsishï 'VB' jevigyklg wh;a jk f.dkq ish,af,a u tl;=jla úIqj,a

fíisla jHdmD;shla jYfhka y÷kajkq ,efí'

by; 'VB IDE'  uqyqKf;a 1 hkqfjka olajd we;s fmdaru ie,iqï ljq¨j

(Form Design Window) jevigyfka Wmfhda.S uqyqK;a (Application Interfaces)

ilialr .ekSu i|yd Ndú; fjhs' rEmfha 2 hkqfjka olajd we;s fldgiska Tn

jevlrñka isák ish¨ jHdmD;s (Project) j, kï yd tu tla tla jHdmD;shlg

wh;a ish¨ fmdaruj, kï ±lafjhs'

rEmh 1'2

4

1

6

2

3

5
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rEmh 1'2 ys olajd we;s ljq¿ ish,a, Tnf.a mß.Kl ;srfhys

we;s ±hs ksÍlaIKh lrkak' hï lsis ljq¿jla ;srfha Èia fkd

fõ kï th ;srh u;g ,nd .kakd wdldrh fidhd n,kak'

rEmh 1'2 ys   3   hkqfjka olajd we;s fldgiska úIqj,a fíisla jHdmD;sfhys

wvx.= ish¨ Wmdx.j, .=Kdx. (Properties) fmkakqï lrhs' tfuka u fuu

,laIKj, w.hka fjkia lsÍug wjYH miqìu o fuu fldgiska i,id fohs'

jHdmD;s ljq¿fjys we;s jHdmD;s kduh u; la,sla lr .=Kdx.

ljq¿fjys jHdmD;sfha kduh 'First Project' f,i fjkia

lrkak'

    rEmh 1'2 ys   4   hkqfjka olajd we;s fldgi fuj,ï fmÜáh (Tool Box)

f,i ye¢kafjhs' 'VB' jevigykla iïmdokh i|yd nyq, j Ndú; jk md,k

(Controls) kï jQ Wmdx. fuu fldgfiys ±lafjhs'

    rEmh 1'2 ys   5   hkqfjka olajd we;s fldgiska ±lafjkafka Tnf.a jevigyk

l%shd;aul l< miq th mß.Kl ;srfha Èiafjk wdldrhhs'

fmdaru ie,iqï ljq¿fjys we;s 'Form 1' u; la,sla lr .=Kdx.

ljq¿fjys 'Caption' hk .=Kdx.h 'First Form' f,i fjkia

lrkak' Tn ,nd .;a fmdarufhys m<, (Width) fldmuK o@

by; rEmfha 6 hkqfjka olajd we;s m%Odk fukqfõ (Main

Menu) Run → Start l%shd;aul lr we;s jk m%;sM,h ksÍlaIKh

lrkak' kej;;a Run → End úOdk ls%hd;aul lr we;s jk

m%;sM,h ksÍlaIKh lrkak'

ls%hdldrlu 1'5

ls%hdldrlu 1'6
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Tn fuf;la ilia l< jHdmD;sh File → Save Project hk úOdk u.ska Tn

leue;s kduhla hgf;a ;ekam;a (Save) lrkak' ^rEmh 1'3 n,kak&

fuys § jHdmD;s ljq¿fjys we;s Tnf.a jHdmD;shg wÞ< ish¨ u fmdaru

;ekam;a lsÍu i|yd wjYH kduhka Tng iemhSug isÿfjhs' ^rEmh 1'4 n,kak&

rEmh 1'3

rEmh 1'4
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m%Odk fukqfõ we;s File → Exit úOdk l%shd;aul lsÍfuka Tng 'VB IDE'

jevigyfkka bj;a úh yels h'

Tn by; § ;ekam;a l< jHdmD;s kduh iys; whslkh u;

oaú-la,sla lr we;sjk m%;sM,h ksÍlaIKh lrkak'

File → Open Project hk úOdkhka l%shd;aul lsÍu u.ska l,ska

wjia:djl ;ekam;a l< jHdmD;shla h<s;a újD; lr .kakd

wkaou fidhd n,kak'

                       1'51'51'51'51'5  úIqj,a fíisla jevigykla f.dvke.Sfï wÈhr  úIqj,a fíisla jevigykla f.dvke.Sfï wÈhr  úIqj,a fíisla jevigykla f.dvke.Sfï wÈhr  úIqj,a fíisla jevigykla f.dvke.Sfï wÈhr  úIqj,a fíisla jevigykla f.dvke.Sfï wÈhr

'VB' mß.Kl NdIdj isoaê Odú; (Event Driven) j¾.fha jevigyka

iïmdokh i|yd ks¾udKh jQ NdIdjls' fujeks NdIdjkaf.ka ksujqKq

jevigykaj, l%shdldß;ajh tu jevigyfka uqyqK; u; Èiafjk jia;+ka u;

mßYS,lhd úiska we;slrk ls%hdjka u; r|d mj;S'

WÞyrK ( 'Click', 'Change', 'GotFocus', 'KeyPress'..

'VB' jevigykl uqyqK;a u; Èiafjk isoaêhla (Events) ckkh l<

yels jia;+ka md,khka (Controls) f,i ye¢kafjhs' 'VB' jevigykla iïmdokh

lsÍfï § 'IDE' uqyqK; u; Èiafjk fmdaru o tjeks md,khlss'

'VB' jevigykla iïmdokh i|yd fhdÞ.; yels md,k úYd, ixLHdjla

fjhs' fuhska ks;r u yd m%Odk f,i Ndú; jk md,k lsysmhla 'IDE' ys we;s

fuj,ï fmÜáfhys ±lafjhs'
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uQisl olajkh (Mouse Pointer)  úIqj,a fíisla fuj,ï fmÜáh u; Èiafjk

whslkhla u;g f.khdfuka Èiafjk fuj,ï b`.s (Tool Tips) u.ska tu whslkhka

fudkjd ±hs wmg ±k.; yels fjhs'

1' fuj,ï fmÜáh u; we;s whslk u;g uQisl olajkh

f.k f.dia tu whslk fudkjd ±hs y÷kd .kak'

2'    'IDE' uqyqKf;a we;s fmdarufha m%udKh ^È. yd m<,& fjkia lrkafka

flfia ±hs fidhd n,kak' fufia fjkia lsÍfï § 'Properties' fldgfia

we;s Wi (Height) iy m<, (Width) ,laIK fjkia jk wdldrh

ksÍlaIKh lrkak'

3'   fuj,ï fmÜáfhys by< ol=Kq fl<jf¾ we;s     whslkh la,sla

lsÍfuka we;sjk m%;sM,h ksÍlaIKh lrkak' m%Odk fukqfjys we;s

View → Tool Box  la,sla lsÍfuka kej; fuj,ï fmÜáh, 'IDE' uqyqK;

u; ,nd.kak'

                   fmdaruhlg md,kfmdaruhlg md,kfmdaruhlg md,kfmdaruhlg md,kfmdaruhlg md,k (Controls) we;=¿ lsÍu'we;=¿ lsÍu'we;=¿ lsÍu'we;=¿ lsÍu'we;=¿ lsÍu'

fuh l< yels m%Odk l%u folls'

1& wjYH md,k u; fojrla la,sla lsÍu ( fuys § tu md,k fmdarufha

ueog ia:dk.; fjhs' fuu md,k miq j wjYH ia:dkhg uQislh u.ska

f.k hd yels h'

2& wjYH md,kh u; uQislh la,sla lr" fmdarufha wjYH ;ekg f.k

f.dia" wjYH m%udKhg uQislh we§u' (Drag)

X
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fmdaruh u; md,k we;=<;a lsÍfï § 'IDE' u.ska tu md,kj, fndfyda

.=Kdx.hkag (Properties) iqÿiq w.hhka iajhxlS%h j ,nd fohs' miq j fuu

w.hhka wjYH f,i .=Kdx. ljq¿j ;=<ska fjkia l< yels h'

'VB' jevigyka f.dvke.Sfï § wkq.ukh l< hq;= wÈhr ;=kls'

1& fmdaruhla u; md,k we;=<;a lsÍu'

2& md,k .=Kdx. (Properties) wjYH f,i fjkia lsÍu'

3& md,kj, l%shdldß;ajh i|yd l%uf,aLkh lsÍu'
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ls%hdldrlu 1'12 rEmfha oelafjk wdldrhg md,k (Control) 7la we;=<;a

lrkak' fuu   md,k 7ys .=Kx.hka my; ±lafjk w.hhkag ilia lrkak'

Tn ks¾udKh l< jevigyk m%Odk fukqfjys we;s File → Save Project

úOdk u.ska 'My Project.Vbp' kñka ;ekam;a lrkak'

fuys § m%:ufhka u Tn ilia lrk ,o fmdaruh ;ekam;a lsÍug isÿ

jk w;r tA i|yd FirstForm hk ku Ndú; lruq'

            a)   Form Object Properties

Name : frmFirst

Caption : First Form

Width : 10000

Height : 6000

             b)  Object 1

Type : Label

Name : 1b1FName

Caption : First Name

Width : 1000

Left : 450

Top : 400

Height : 200

              c)  Object 2

Type : Label

Name : 1b1LName

Caption : Last Name

Width : 1000

Left : 450

Top : 950

Height : 200

 d)  Object 3

Type : Label

Name : 1b1FullName

Caption : Full Name

Width : 1000

Left : 450

Top : 1500

Height : 200
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e) Object 4

Type : Text Box

Name : txtFName

Width : 3000

Left : 1600

Top : 400

Height : 200

Text :

f) Object 5

Type : Text Box

Name : txtLName

Width : 1600

Left : 1600

Top : 950

Height : 200

Text :

g) Object 6

Type : Text Box

Name : txtFullName

Width : 5000

Left : 1600

Top : 1500

Height : 200

Text :

h) Object 7

Type : Command Button

Name : cmdFullName

Caption : Display Full Name

Width : 2500

Left : 450

Top : 2500

Height : 200
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                       1'6 md,khl l%shdldß;ajh i|yd fla;hka1'6 md,khl l%shdldß;ajh i|yd fla;hka1'6 md,khl l%shdldß;ajh i|yd fla;hka1'6 md,khl l%shdldß;ajh i|yd fla;hka1'6 md,khl l%shdldß;ajh i|yd fla;hka     (Code) ,sùu' ,sùu' ,sùu' ,sùu' ,sùu'

fï i|yd by; l%shdldrlu ;=<ska iïmdokh lr .;a jHdmD;sh kej;

újD; lrkak'

fuu uqyqK; u; we;s "Display Full Name" hkqfjka ±lafjk úOdk fnd;a;u

(Command Button) u; oaú-la,sla (Double Click) lsÍfuka my; ±lafjk wdldrfha

uqyqK;la ,nd.ekSug yels fjhs'

rEmh 1'6
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fuu uqyqK; fla; ljq¿j (Code Window) f,i ye¢kafjhs' hï lsis

md,khla iuÕ fla;hla iïnkaO lsÍu i|yd fuu uqyqK; fhdÞ .efka'

uqyqKf;a osiafjk fla; my; olajd we;'

Private Sub cmdFullName_Click()

End Sub

fuu fla; w;rg my; oelafjk fla;hka we;=<;a lrkak'

Private Sub cmdFullName_Click()

txtFullName.Text = txtFName.Text & “  “ & txtLName.Text

End Sub

bka miq j jHdmD;sh ;ekam;a lrkak'

fufia iïmdokh l< jevigyk m%Odk fukqfõ we;s 'Run'  u.ska

l%shdlrjd Èiafjk uqyqK; u; 'First Name' yd 'Last Name' bÈßfhys lsishï

YsIHfhl=f.a m<uq ku yd wjidk ku h;=re ,shkh lr 'Display Full

Name' hk úOdk fnd;a;u la,sla lr we;s jk m%;sM,h ksÍlaIKh lrkak'

rEmh 1'7

ls%hdldrlu 1'13
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'VB' jevigykla 'VB' wkq l%uf,aLk (Sub Program) lsysmhl tl;=jla

f,i ie,lsh yels h' tneúka 'VB' wkq jevigyla f.dv kÕd.ekSug wjYH

lreKq i,ld n,uq'

                   úIqj,a fíisla l%uf,aLkhl ixhq;shúIqj,a fíisla l%uf,aLkhl ixhq;shúIqj,a fíisla l%uf,aLkhl ixhq;shúIqj,a fíisla l%uf,aLkhl ixhq;shúIqj,a fíisla l%uf,aLkhl ixhq;sh

'VB' jevigykla m%Odk f,i fmdaruhlska fyda fmdaru lsysmhlska

iukaú; úh yels h' 'VB' ys 'IDE' wdrïN lsÍfï § fmdaruhla iajhxl%Sh j

ks¾udKh lrfokq ,nhs' jevigykg ;j;a fmdaru wjYH úg Project → Add

Form úOdk l%shd;aul lsÍfuka wjYH fmdaru ,nd .; yels h' 'VB' jevigykl

fmdaruhka jevigyfka w;=re uqyqK;a ks¾udKh i|yd fhdÞ .efka' jevigyfka

w;=re uqyqK;a ks¾udKh lsÍu i|yd wjYH uQ,sl md,khka fuj,ï fmÜáfhka

f;dard .; yels h'

iEu md,khla yd wkqnoaO j y÷kajd we;s isoaê (Events) /ila fjhs' fuu

l%shdldrlï wÞ< jevigykg wkql+, j isÿ úh hq;= wdldrh ld¾h mámdáhla

(Procedure) u.ska ±laúh yels h' ld¾h mámdáhla úOdk tl;=jlska iukaú;

l%uf,aLhla (Program) f,i ye¢kaúh yels h'

'VB' jevigykla l%shd;aul l< úg thg wÞ< fmdaruhka yd tu fmdaruhka

u; ks¾udKh l< md,k ;srh u; Èiafjhs' mßYS,lhdg fuu md,k u; w¾:

olajd we;s ld¾hhka (Click, Move, Drag jeks) lsÍfuka jevigyk yeisrúh yels

h' mßYS,lhd lsis hï md,khla u; ld¾hhla lsÍfï § thg wÞ< j we;s ld¾h

mámdáh ls%hd;aul fjhs'

'VB', fmdaruhla u; úOdk fnd;a;ï md,khla (Command

Button Control) ks¾udKh lrkak' fuu úOdk fnd;a;ï u;

oaú-la,sla lsÍfuka fla; ljq¿j ,nd .kak' fuu fla; ljq¿fjka

isoaê (Event) fldgig msúi ̂ my; rEmigyfka olajd we;'& úOdk fnd;a;ula

u.ska ckkh l< yels ls%hdldrlï ksÍlaIKh lrkak' fuu isoaê f;dard .;a

úg fla; ljq¿fjys we;s jk fjkialï ksÍlaIKh lrkak'

ls%hdldrlu 1'14
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     úIqj,a fíisla úfYaIs; moúIqj,a fíisla úfYaIs; moúIqj,a fíisla úfYaIs; moúIqj,a fíisla úfYaIs; moúIqj,a fíisla úfYaIs; mo (Reserved Words / Key Words)

'VB' mß.Kl NdIdfjys o wfkla fndfyda mß.Kl NdIdjkays fuka

úfYaIs; mo f,i w¾: ±lajQ jpk ,ehsia;=jla fjhs' 'Private', 'Sub' iy 'End', 'If',

'End If' fï i|yd WÞyrK lsysmhls' 'VB' l%uf,aL f.dvkeÕSfï § fuu jpkj,

Ndú;h tAjdfha w¾:hkag wkql+, j isÿ l< hq;= h' WÞyrKhla f,i 'Sub' hk

jpkh 'VB' ld¾h mámdáhl wdrïNh ±laùu i|yd o 'End Sub' hk jpk tu

ld¾h mámdáfhys wjidkh ±laùu i|yd o fhdÞ .efka' úfYaIs; mo úIqj,a

fíisla fla; ljq¿fjys ks,a meyefhka Èiafjhs'

                   úIqj,a fíisla ld¾h mámdá  úIqj,a fíisla ld¾h mámdá  úIqj,a fíisla ld¾h mámdá  úIqj,a fíisla ld¾h mámdá  úIqj,a fíisla ld¾h mámdá  (VB Procedures)

óg fmr ±lajQ mßÈ 'VB' jevigykla ld¾h mámdá lsysmhl tl;=jla

f,i ie,lsh yels h' 'VB' ld¾h mámdá j¾. ;=kls'

1)   isoaê ld¾h mámdá  (Event Procedures)

2)   fmdÿ ld¾h mámdá (General Procedures)

3)   ls%hd ld¾h mámdá (Function Procedures)

fmdaruhl jQ md,k (Controls) yd ne÷Kq ld¾h mámdá" isoaê ld¾h mßmdá

(Event Procedures) f,i ye¢kafjhs' fuu ld¾h mámdá l%uf,aLhl 'Private Sub'

hk jpk u.ska wdrïN fjhs' fujeks ld¾h mámdáhla wÞ< fmdaruhg muKla
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wdfõ‚l jk w;r 'VB' jevigyfka fjk;a fmdaru u; jQ md,k u.ska l%shd;aul

l< fkd yels h'

md,k yd fkdne÷Kq ld¾h mámdá, fmdÿ ld¾h mámdá (General

Procedures) f,i ye¢kafjhs' fujeks ld¾h mámdáj, wdrïN i|yd 'Private Sub'

fyda 'Public Sub' hk úfYaIs; mo fhdÞ .; yels h' 'Private Sub' hkqfjka wdrïN

l< ld¾h mámdáh wÞ< fmdaruhg muKla wdfõ‚l jk w;r 'Public Sub'

hkqfjka wdrïN l< ld¾h mámdáh 'VB' jevigykl wvx.= ́ kE u fmdaruhla

;=<ska l%shd;aul l< yels h'

ls%hd ld¾h mßmdá (Function Procedures) wfkla j¾.j, ld¾h

mámdáj,ska fjkia jkafka flfia ±hs fidhd n,kak' ls%hd

ld¾h mßmdáhla l%uf,aLhlg we;=<;a lsÍfï § Ndú; l<hq;=

wdrïNl uQ, mo (Keywords) fudkjd ±hs fidhd n,kak'

iDcqfldaKdi%hl È. yd m<, § we;s úg tys j¾.M,h fiùu i|yd 'VB'

ld¾h mámdáhla f.dvkÕd .kakd wdldrh fidhd n,uq' fuys § fuu jevigyk

i|yd wjYH w;=re uqyqK; (Interface) uq,ska u ie,iqï l< hq;= fjhs' fuu

.eg¨j úi£u i|yd my; ±lafjk wdldrfha w;=re uqyqK;la fhdÞ .; yels h'

fuys 'Length', 'Height' yd 'Area' hk md,k" f,an, md,k (Label Controls)

jk w;r tu md,kj,g bÈßfhka mdG fldgq md,k (Text Box Controls) fjhs'

'Compute' hk md,kh (Command Button Control) fjhs'

rEmh 1'8

ls%hdldrlu 1'15
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fuu uqyqKf;ys 'Length' yd 'Height' i|yd w.hhka imhd 'Compute' hk

úOdk fnd;a;u la,sla l< úg jevigyk u.ska iDcqfldaKdi%fha j¾.M,h

.Kkh lr tu w.h 'Area' hk fldgfiys igyka l< hq;= fjhs' fuh isÿlsÍu

i|yd 'Compute' hk md,khg úOdk tl;=jla iïnkaO l< hq;= fõ'

fuu .‚;l¾uh lsÍu i|yd úOdk fnd;a;u u; la,sla hk isoaêh i|yd

iïnkaO l<hq;= l%uf,aLhla my; ±lafjhs'

Private Sub cmdCompute_Click()

L = Val(txtLength.Text)

H = Val(txtHeight.Text)

Area = L * H

txtArea.Text = Area

End Sub

    fuu l%uf,aLfha my; ±lafjk ,laIK ksÍlaIKh l< yels h'

1' l%uf,aLh 'Private Sub' hk úfYaIs; moh u.ska wdrïN lr we;s ksid iy

'End Sub' j,ska wjika ù we;s ksid fuh ld¾h mámdáhls' tfuka u fuys

'Private' hk úfYaIs; moh we;s neúka fuh wÞ< fmdaruh ;=<ska muKla

l%shdlrúh yels ld¾h mámdáhls' fuu 'Private Sub cmdCompute_Click ()'

hk m%ldYh úOdkhla fkdjk w;r th l%uf,aL mßj¾;lhg fuu l%uf,aL

LKavh wkq jevigyk (Sub - Program) wdrïNh jYfhka olajkq ,nhs'

2' fuu ld¾h mámdáh y÷kd.ekSu i|yd 'cmdCompute_Click()' hk ku fhdÞ

we;' fuys 'cmdCompute' hk ku úOdk fnd;a;fuys ku jk w;r '_Click'

hk fldgi 'VB' u.ska fuh la,sla hk isoaêhg wÞ< nj ±laùu i|yd

iajhxl%Sh j ,nd ÿka fldgils'

3' ld¾h mámdáfhys wka;¾.;h (Body) úOdk lsysmhl tl;=jls' fuu

úOdkhka tl fma<shlg tl úOdkhla jk f,i fma<s lsysmhlg f.dkq

lr we;' fufia tla fma<shl ±lajQ úOdk m%ldYhla (Statement) f,i

ye¢kafjhs'
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4' ld¾h mámdáhys m<uq jk úOdkh

L = Val (txtLength.Text)

fjhs' fuys wvx.= '='  hk i,l=K 'Assignment Operator' f,i ye¢kafjhs'

fuu i,l=K 'VB' u.ska lsishï ld¾hhla (Operation) l< hq;= nj olajk

i,l=Kls' fujeks lsishï ld¾hhla isÿ l< hq;= nj olajk ixfla; fyda

kduhka 'Operators' f,i ye¢kafjhs' fuys jï mi we;s 'L' hkak úp,Hhls'

úp,Hh" uQ,sl f,i mß.Klfha m%Odk u;lfha we;s fldgila weu;Su

i|yd Ndú; l< yels kduhla f,i ie,lsh yels h' fuys '=' hk 'Operator'

ys uQ,sl ld¾hh jkafka ol=Kq mi olajd we;s l¾uhka isÿ lr ,efnk

m%;sM,h jïmiska olajd we;s úp,Hfhka y÷kajk u;lfhys jQ fldgfiys

;ekam;a lrk f,i h' fuys 'Val (txtLength.Text)' hk fldgfiys 'txtLength'

hkafkka olajkafka 'txtLength' hkqfjka kïlr we;s md,kfha text hk

.=Kdx.fha w.h ,nd .kakd f,i h' fuf,i lsishï md,khl ,laIKhg

wÞ< w.h

Control Name. Property Name

hk wdlD;sh Ndú;fhka ,nd.; yels h' fuys 'Val' hkak 'VB' u.ska y÷kajd

we;s Y%s;hls' fuu Ys%;fhka isÿ lrkafka 'txtLength' ys we;s w.h .‚;uh

w.hla njg mßj¾;kh lsÍuhs'

5' Area = L* H ys jQ '*' ixfla;fhka .=‚;h ±lafjhs' fuys § isÿjkafka

'L' yd 'H' hk úp,Hhkag wÞ< w.hhka u;lfhka ,nd f.k tu w.hhkaf.a

.=‚;h isÿ lr ,efnk m%;sM,h 'Area' hk úp,Hfhys ;ekam;a lsÍuhs'

6' wjidk 'Statement' tl jk txtArea.Text = Area  u.ska 'txtArea' hk md,kfha

'Text' hk ,laIKhg Area hk úp,Hfha w.h wdfoaY lrk fuka olajd

we;'

by; ld¾h mámdáh úYaf,aIKfha § my; ±lafjk m%Odk lreKq ±l.; yels h'

1'  ld¾h mámdáhla m%ldY lsysmhl tl;=jls'

2'  ld¾h mámdáhla ;=< w.hhka ;djld,sl j ;nd .ekSu i|yd úp,Hhka

 Ndú; l< yels h'
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3' 'VB' u.ska isÿ l< hq;= ld¾hhka ±laùu i|yd m%ldY Wmfhda.S lr .efka'

fujeks m%ldY úp,Hhkaf.ka yd úúO j¾.fha 'VB' l¾uhka (Operators)

f.ka ks¾udKh ù we;'

4' 'VB' ys fmdaruhl jQ md,khl lsishï ,laIKhl w.h 'ControlName.Property

Name' hk wdlD;sh u.ska ,nd .ekSug fyda fjkia lsÍug yels h'

by; ±lajQ isoaê ld¾h mámdáh (Event Procedure) fmdÿ ld¾h mámdáh

(General Procedure) yd isoaê ld¾h mámdáfhys tl;=jla f,i my; ±lafjk mßÈ

o iïmdokh l< yels h'

Private Sub cmdCompute_Click ()

Call ComputeArea (Val(txtLength.Text),Val(txtHeight.Text))

End Sub

Sub ComputeArea (L,H)

Area=L*H

txtArea.Text=Area

End Sub

fuys 'ComputeArea' hkak md,khla yd ne÷Kq ld¾h mámdá fkdjk

neúka th fmdÿ ld¾h mámdáhla f,i ±laúh yels h' tneúka th jevigyfka

jQ wfkla ´kE u ld¾h mámdáhla u.ska l%shd;aul l< yels ld¾h mámdáhls'

by; úia;r l< 'VB' jevigyk iïmdokh lrkak' tu

jevigyk l%shd;aul lr ,efnk w.hhka ksÍlaIKh lrkak'

ls%hdldrlu 1'16
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                   újrKújrKújrKújrKújrK     (Comments)

l%uf,aLhla ms<sn| úia;r l%uf,aLh ;=< u f,aLk.; lsÍu i|yd újrK

Wmfhda.S lr .efka' újrK l%uf,aLhl we;s wfkl=;a úOdk fuka l%shd;aul

l< fkd yels h' l%uf,aLhla ;=< újrK wka;¾.; lsÍfï uQ,sl mrud¾:h

jkafka tu l%uf,aLh myiqfjka f;areï .ekSug wjYH úia;r imhd §uhs' 'VB'

l%uf,aLhl újrK we;=<;a lsÍu i|yd ' hk úfYaI ixfla;h fyda 'Rem' hk

Reserved word tl Ndú; lrhs' fuu ixfla;h ±lajQ ia:dkfha isg tu fma<sfha

wjidkh f;la jQ ish¨ úia;r újrK tflys wka;¾.;h f,i ie,flhs' hï

úia;rhla hdno fma<s lsysmhla ;=< úys§ hk wjia:djkays § tA iEu fma<shla u

fuu úfYaI i,l=fKka (') fyda 'Rem' j,ska wdrïN úh hq;= h' 'VB IDE'  ys

újrK fld< j¾Kfhka olajkq ,efí'

WÞyrK ( Program  8

‘  -----------------------------------------------------------

‘ sub program to add two numbers

‘ -----------------------------------------------------------

Private Sub cmdAddNos_Click()

Sum= 0

‘ Add two numbers

Sum = Val(txtFirst.Text) + Val(txtSecond.Text)

txtTotal.Text  = Sum  ‘ Print the Result

End Sub

        1'   by; WÞyrKfhys we;s újrK fudkjd ±hs fidhd

     n,kak'

2' sum = val(txtFirst.text)+Val(txtSecond.text) hk fma<sh

'sum = val(txtFirst.text)+Val(txtSecond.text)  hk wdldrhg fjkia l<

fyd;a we;s jk m%;sM,h idlÉPd lrkak'

ls%hdldrlu 1'17
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                    úIqj,a fíisla o;a; j¾.úIqj,a fíisla o;a; j¾.úIqj,a fíisla o;a; j¾.úIqj,a fíisla o;a; j¾.úIqj,a fíisla o;a; j¾.

'VB' ys Ndú; l< yels o;a; (Data), tAjdfha iajNdjh" tAjd .nvd lsÍug

wjYH bv m%udKh yd tAjd u; ls%hd l< yels l¾uhka mokï lr úúO mx;sj,g

j¾.SlrKh flf¾' fuu úúO o;a; j¾.hka 'Data Types' f,i ye¢kafjhs'

'VB' u.ska y÷kajd § we;s 'Data Types' uQ,sl mx;s lsysmhlg fnÈh yels h'

1' nQ,shka (Boolean) - 'True' yd 'False' hk w.hkag muKla iSudfjhs' 'VB'

u.ska 0 w.h nQ,sh 'False' w.hg iudklr we;s w;r

wfkl=;a ish¨ w.hhka  nQ,sh 'True' f,i i,lhs'

fuu j¾.fha w.hhka u; 'AND', 'OR', 'NOT' hk

nQ,sh l¾uhka w¾: olajd we;'

2' ixLHd;aul (Numeric) - ish¨ ixLHd fuu j¾.hg wh;a fjhs'

jevigyk ;=< Ndú; lsÍug n,dfmdfrd;a;= jk w.hhkaf.a úYd,;ajhka

wkqj ixLHd;aul o;a; mka;sh Wm mka;s mylg fnÞ we;'

1. Byte

2. Integer

3. Long

4. Single

5. Double

fuhska 'Byte' 'Integer' yd 'Long' hk o;a; mx;s ksÅ, ixLHd ^mQ¾K ixLHd&

i|yd o 'Single' yd 'Double' hk o;a; mx;s oYu ia:dk iys; ;d;aúl ixLHd

l<ukdlrKh i|yd w¾: olajd we;'

3. ;ka;= (String) :   wlaIr" b,lalï yd ixfla;j,ska ieÿï,;a o;a; fuu .Khg

.efka' "Sri Lanka", "Low"  fï i|yd WÞyrK lsysmhls' fuu

j¾.fha o;a;hka ieu úg u " " hk ixfla; ;=< ±laúh hq;= h'

ixLHd o 'String' f,i ±laúh yels h' fuys § fuu ixLHd " " hk
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i,l=K ;=< úh hq;= h' ixLHd 'String' f,i ±lajQ úg tu ixLHd

u; 'Numeric' j¾.fha o;a; u; Ndú; l< yels l¾uhka fhoúh

fkd yels h' 'String' j¾.fha o;a;hka u; l< yels l¾uhka

w;ßka 'String Concatenation' m%Odk ;ekla .kshs' fï i|yd '&'

hk ixfla;h Ndú; lrk w;r fï u.ska fuu j¾.fha o;a;hka

tlsfklg wE£u isÿ l< yels h'

WÞyrK # "My name is" & "Saman" hk m%ldYkfha & l¾uh isÿ l<

úg "My name is Saman" hk 'String' tl m%;sM,h fjhs'

Currency - uQ,Huh w.hka l<ukdlrKh i|yd w¾: olajd we;'

fuu j¾.fha w.hhka i|yd oYu ia:dkhg miq j b,lalï

y;rla Ndú; l< yels h'

Date - Èkhka yd fõ,djka l<ukdlrKh i|yd w¾: olajd we;s

o;a; mx;shls'

Variant - by; ish¨ j¾.hkaf.a o;a; fuu mx;shg .efka'

             1'7              1'7              1'7              1'7              1'7   úp,H  úp,H  úp,H  úp,H  úp,H ^̂̂̂̂Variables&&&&&

l%u f,aLhla o;a; u; l%shdlrùfï § wÞ< o;a; m%Odk u;lfha ^RAM&

;nd .ekSug wjYH fjhs' fufia o;a; ;djld,sl j u;lfha ;nd .ekSu i|yd

úp,H (Variables) Ndú; l< yels h' mß.Klfha m%Odk u;lfha ksYaÑ; fldgilg

m%fõY ùu i|yd Wmfhda.s lr .; yels ixfla; kduhla f,i úp,Hhla ±laúh

yels h' fuf,i" u;lfha lsis hï fldgilg úp,Hhla wkqnoaO l< úg tu

úp,Hh Wmfhda.s lr f.k tu wÞ< u;l fldgfia úúO o;a; .nvd lsÍu yd

kej; ,nd .ekSu isÿ l< yels h'

WÞyrK - 1

A } 25 hk m%ldYkh i,ld n,uq' fujeks m%ldYkhla l%uf,aLhl

wvx.= l< úg th mß.Klhg lsishï úOdkhla ,nd fohs' fuu úOdkh

l%shdlrùfï § isÿ jk ld¾hhka my; ±lafjhs'
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01' mß.Klfha m%Odk u;lfha fldgila A kï jQ úp,Hh i|yd ,nd .ekSu'

02' fuu fldgig A hk ixfla; kduh ;djld,sl j wkqnoaO lsÍu'

03' A hkqfjka y÷kajd ÿka u;l fldgfia 25 hk w.h .nvd lsÍu'

WÞyrK - 2

A } 10

B } 20

C } A + B

by; m%ldYk mß.Kl l%uf,aLhla f,i l%shd;aul lsÍfï § isÿ jk

l%shdj,sh my; ±lafjhs'

01' by; ±lajQ mßÈ mß.Klfha m%Odk u;lfha fldgilg A hk ixfla;

kduh ;djld,sl j wkqnoaO lsÍu yd tu fldgfia 10 hk w.h .nvd

lsÍu'

02' fuf,i u u;lfha fjk;a fldgilg B hk ixfla; kduh wkqnoaO

lsÍu yd tu fldgfia 20 hk w.h .nvd lsÍu'

03' A fldgfia ;ekam;a lr we;s w.hg B fldgfia .nvd lr we;s w.h tl;=

lr m%;sM,h u;lfha fjk;a fldgil .nvd lsÍu yd tu fldgig C hk

ixfla; kduh wkqnoaO lsÍu'

by; oelajQ úOdk l%shd;aul lsÍfï § mß.Klfha m%Odk u;lfha we;s

jk m%Odk fjkialï my; rEm igyfkka ±lafjhs'

A = 10

B = 20

C = A+B

123456789012345678901
123456789012345678901
123456789012345678901
123456789012345678901
123456789012345678901
123456789012345678901
123456789012345678901

C

30

123456789012345678901
123456789012345678901
123456789012345678901
123456789012345678901
123456789012345678901
123456789012345678901
123456789012345678901
123456789012345678901

A

10

123456789012345678901
123456789012345678901
123456789012345678901
123456789012345678901
123456789012345678901
123456789012345678901
123456789012345678901

B

20
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úp,H ms<sn| wjfndaO lr .; hq;= uQ,sl f;dr;=reúp,H ms<sn| wjfndaO lr .; hq;= uQ,sl f;dr;=reúp,H ms<sn| wjfndaO lr .; hq;= uQ,sl f;dr;=reúp,H ms<sn| wjfndaO lr .; hq;= uQ,sl f;dr;=reúp,H ms<sn| wjfndaO lr .; hq;= uQ,sl f;dr;=re

1' mß.Klfha m%Odk u;lfha o;a; ;ekam;a lsÍu i|yd fjka lr .;aa

fldgil ixfla; kduhla f,i úp,Hhla ±laúh yels h'

2' úp,Hhla yd wkqnoaê; u;lfha úúO wjia:dj, § úúO w.hka ;ekam;a

l< yels h' fuf,i tl u úp,Hhg úúO wjia:djkays úúO w.hka

;ekam;a lsÍfï § wjidk jYfhka ;ekam;a l< w.h u.ska Bg fmr

;ekam;a l< w.h m%;sia:dmkh fjhs'

WÞyrK (

A = 10

A = 20

fuys § m<uq wjia:dfõ § u;lfha fldgilg A ixfla; kduh wkqnoaO

lr tu fldgfia 10 hk w.h .nvd lrkq ,nhs' fojeks wjia:dfõ § A

kï jQ u;l fldgfia we;s w.h 20 hk w.fhka m%;sia:dmkh lrkq

,nhs'

3' u;lfha fldgia úp,H i|yd fjka lsÍu ;djld,sl l%shdj,shls'

l%uf,aLhla l%shd;aul lr wjika jQ úg úp,H i|yd ,nd.;a u;lfha

ish¨ fldgia ksoyia fõ'

úp,H kï lsÍu úp,H kï lsÍu úp,H kï lsÍu úp,H kï lsÍu úp,H kï lsÍu  (Naming Variables)

úp,Hhla i|yd ixfla; kduhla fh§fï § wkq.ukh l< hq;= kS;s

iuQyhla we;' fuu kS;s" l%uf,aL ,sùu i|yd fhdÞ .kakd mß.Kl NdIdj u;

r|d mj;S'

úIqj,a fíisla úp,Hhkaf.a kduhka my; kS;sj,g wkqj ;eksh hq;= h'

1' bx.%sis fydaäfha wl=rlska wdrïN úh hq;= h'

2' m<uq wlaIrhg miq j tk wlaIr i|yd bx.%Sis fydaäfha wl=re" b,lalï

fyda z-Z (underscore) ixfla;h fhdÞ.; yels h'

3' úp,Hhl kug ;sìh yels Wmßu wlaIr m%udKh 255ls'

4' úIqj,a fíisla úOdkhka i|yd ,nd § we;s kduhka úp,H kduhka f,i

Ndú; fkd l< hq;=hs'

'VB' úOdk i|yd ,nd § we;s kduhka úfYaIs; mo (Reserved Words) f,i

ye¢kafjhs'
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my; ±lafjk kduhkaf.ka l=uk kduhka 'VB' úp,H kduhka

f,i Ndú; l< yels o@ Ndú; l< fkdyels kduhka Ndú;

l< fkdyelafla uka±hs meyeÈ,s lrkak'

1) A5 6) Name?

2) MyName 7) abc

3) My_Name 8) 1f

4) My  Name 9) 5A

5) _ Name 10) A_5

             úp,H w¾: ±laùu         úp,H w¾: ±laùu         úp,H w¾: ±laùu         úp,H w¾: ±laùu         úp,H w¾: ±laùu

jevigyka iïmdokfha § wjYH úp,Hhkays o;a; j¾. (Data types) jevigyk

wdrïNfha § m%ldY l< yels h' fujeks m%ldYk úp,H w¾: ±laùfï m%ldYk

(Variable Declarations) f,i ye¢kafjhs'

'VB' úp,Hhka ys o;a; mx;s m%ldY lsÍu i|yd 'Dim' hk rlaIs; moh 'As' hk

rlaIs; moh iuÕ fhdÞ .efka'

WÞyrK # Dim Value1 As Boolean

Dim  Value2 As Boolean

Dim  Name As String

fuu WÞyrKfha § 'Value1' yd 'Value2' hk úp,Hhkays o;a; mx;sh 'Boolean'

f,i o 'Name' úp,Hh 'String' j¾.fha úp,Hhla f,i o m%ldY lr we;'

'VB' jevigykl w¾: fkd±lajQ ish¨ úp,H 'Variant' j¾.fha úp,H f,i

i,lkq ,nhs'

ls%hdldrlu 1'18
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'

VB' ys úp,H Ndú;hg fmr w¾: ±laùu w;HjYH fkd fõ'

tkuq;a úp,Hhkays o;a; mx;s Ndú;hg fmr m%ldY lsÍfuka

we;sjk m%fhdack lsysmhls' fuu m%fhdack fudkjd ±hs

idlÉPd lrkak'

'Numeric' yd 'String' hk o;a; j¾. u; l< yels úúO l¾uhka

fudkjd ±hs fidhd n,kak' fujeks l¾uhka 'VB' l%uf,aLhl

fh§fï § wkq.ukh l<hq;= kS;s fudkjd ±hs wOHhkh lrkak'

           .‚; l¾u          .‚; l¾u          .‚; l¾u          .‚; l¾u          .‚; l¾u     (Mathematical Operators)

+ tl;= lsÍu (Addition)

- wvq lsÍu (Subtraction)

* .=K lsÍu (Multiplication)

/ fn§u (Division)

^ n,h (Power)

\ ksÅ, fn§u (Integer division)

Mod fYaIh (Remainder)

ls%hdldrlu 1'20

ls%hdldrlu 1'19
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                      1'8 1'8 1'8 1'8 1'8   l¾u m%uqL;d   l¾u m%uqL;d   l¾u m%uqL;d   l¾u m%uqL;d   l¾u m%uqL;d  (Operator Precedence)

my; .‚;uh m%ldYh i,ld n,kak'

5 -3Í 2

fuu m%ldYh fohdldrhlg iq¿ l< yels h'

5-^3Í2& = -1 ^5-3& Í2 = 4

fujeks m%ldYk úúO wdldrhg iq¿ l< úg ,efnk m%;sM, fndfyda úg

tlsfklg fjkia fõ' tneúka m%ldYhl úúO j¾.fha .‚;uh l¾uhka we;súg

tu m%ldYh iq¿ lsÍfï § l¾uhka i|yd Èhhq;= m%uqL;d w¾: olajd we;' fuu

m%uqL;d 'Operator Precedence' f,i ye¢kafjhs' .‚;uh l¾uhka ys m%uqL;d

my; ±lafjk mßÈ fjhs'

l¾uh m%uqL;d wkqms<sfj<

  (1) ( )

  (2) ^

  (3) * , /

  (4) +, -

WÞyrK #

5Æ2Í3-5Λ2

l¾uhkaf.a m%uqL;djkag wkql+, j by; m%ldYh iq¿ l, hq;= whqre jryka

fhdÞ my; mßÈ fmkajd Èh yels h'

jryka fh§fuka m%ldYkhl l¾uhhka i|yd ,nd § we;s m%uqL;d fjkia

l< yels h'

((5 +(2 * 3)−(5 ^ 2))

= ((5 +(2 * 3)−25)

= ((5 + 6)−25)
= 11−25

= −14

> > > >

3 2 4 1
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jryka fh§fuka m%ldYhl wvx.= .‚; l¾uhkays m%uqL;d

fjkia jk whqre idlÉPd lrkak'

                     fldkafoais.; l¾u fldkafoais.; l¾u fldkafoais.; l¾u fldkafoais.; l¾u fldkafoais.; l¾u     (Conditional Operators)

fujeks l¾u m%ldY u; l%shd l< úg ,efnk m%;sM,h nQ,sh (True or False)

w.hla fjhs'

             l¾uh        f;areu

= iudk (Equal to)

> úYd, (Greater than)

< l=vd (Less than)

>= úYd, fyda iudk (Greater than or equal to)

<= l=vd fyda iudk (Less than or equal to)

<> wiudk (Not equal to)

WÞyrK #

m%ldYk               m%;sM,h

1) 5 = 6 False

2) 3 + 5 = 4 + 4 True

3) 5 < 6 True

4) 6 < 5 False

5) 5 < > 6 True

6) 5 < = 6 True

7) 6 < = 5 False

fujeks fldkafoais.; l¾u m%ldY u; l%shd;aul lsÍfï §" tu m%ldYfha

l¾uhg ol=Kqmi yd jïmi ixlS¾K m%ldY jQ úg tu m%ldY ;ks w.hlg iq¿

flf¾' bka miq fuu ;ks w.hhka u; wÞ< l¾uh l%shd;aul lrjd kshñ; nQ,sh

m%;sM,h ,ndfohs'

ls%hdldrlu 1'21



fkdñf,a fnÞyeÍu i|yd h' 39

WodyrK #

(5 * 3) + 2 > (6 / 2) * 5

fuu m%ldYh m<uq j my; ±lafjk f,i ;ks mo iys; m%ldYkhlg iq¿

flf¾'

17 > 15

17 hk ixLHdj 15g jvd úYd, ksid fuu m%ldYfha m%;sM,h True f,i ,nd

fohs'

        ;d¾lsl l¾u  ;d¾lsl l¾u  ;d¾lsl l¾u  ;d¾lsl l¾u  ;d¾lsl l¾u  (Logical Operators)

fuu j¾.fha l¾uhka ;d¾lsl (Logical) o;a; j¾.h u; w¾: olajd we;s

l¾uhka fjhs' uQ,sl ;d¾lsl l¾u j¾. ;=kls' fuu l¾uhka ;=k 'AND', 'OR'

iy 'NOT' jYfhka y÷kajd § we;s w;r tAjdfha w¾:hka my; ±lafjk i;H;d

j.= (Truth Tables) u.ska ±lafjhs'

^nQ,Sh úp,H yd l¾uhka ms<sn| meyeÈ,s lsÍula 10 jk fY%a‚fha 4 jk

mßÉfþofha olajd we;'&

my; i;H;d j.=fõ 'a' yd 'b' hkq nQ,sh úp,H fjhs'

AND

WÞyrK #

(2 > 3) AND (3 > 2) hk m%ldYh i,lkak'

fuys AND hk l¾uh l%shd;aul l< yelafla nQ,Sh j¾.fha w.hhka u;

muKla neúka m<uq j m%ldYfha ol=Kqmi iy jïmi iq¿lr nQ,Sh w.hhka

,nd.; hq;= fjhs' 2 > 3 hkak 'False' jk w;r 3 > 2 hkak 'True' fjhs' bka miq

'False AND True' hk m%ldYfha m%;sM,h by; i;H;d j.=jg wkqj 'False' úh hq;=

h' tneúka by; m%ldYfha wjidk w.h nQ,Sh jk w;r tu w.h 'False' f,i

±laúh yels h'

           a    b     a AND b

         True True       True

         True False       False

         False True       False

         False False       False
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OR

NOT

by; j.=j,ska olajd we;s mßÈ 'AND' iy 'OR' oaúuh l¾uhka jk w;r

'NOT' hkak tAluh l¾uhla fjhs'

AND iy OR hk nQ,sh l¾uhkaf.a l%shdldß;ajh fmkaùu

i|yd my; ±lafjk mßÈ w;=re uqyqK;la we;s jevigykla

iïmdokh lrkak'

  Control Number               Type            Name

1 Combo Box cboAndLeft

2 Command Button cmdAnd

3 Combo Box cboAndRight

4 Label lblAndEqual

5 Text Box txtAnd

6 Combo Box cboOrLeft

7 Command Button cmdOr

 8 Combo Box cboOrRight

 9 Label lblOrEqual

 10 Text Box txtOr

 a    b           a OR b

    True True  True

True False  True

False True  True

False False  False

a  NOT a

          True   False

          False   True

1 2 3 4
5

10
9876

ls%hdldrlu 1'22
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1" 3" 5" yd 7 hk md,kj, ‘Data Format’ ,laIKh nQ,Sh f,i o ‘List’

,laIKh i|yd ‘True’ iy ‘False’ w.hka o ,nd fokak' ‘Combo Box’ ys ‘List’

,laIKh i|yd w.hka lsysmhla ,nd §fï § tla w.hla we;=<;a lsÍfuka miq

‘Ctrl + Enter’ h;=re ;o lsÍfuka B<Õ w.h we;=<;a l< yels h'

by; cmdAnd yd cmdOr úOdk fnd;a;ïj, Click Events i|yd my; ±lafjk

fla; we;=<;a fldg jev igyk l%shd;aul lrkak'

              Program 9

Private Sub cmdAnd_Click()

Dim LeftAndValue As Boolean

Dim RightAndValue As Boolean

Dim ResultAnd As Boolean

LeftAndValue = cboAndLeft.List(cboAndLeft.ListIndex)

RightAndValue = cboAndRight.List(cboAndRight.ListIndex)

ResultAnd = LeftAndValue And RightAndValue

txtAnd.Text = ResultAnd

End Sub

Private Sub cmdOr_Click()

Dim LeftOrValue As Boolean

Dim RightOrValue As Boolean

Dim ResultOr As Boolean

LeftOrValue = cboOrLeft.List(cboOrLeft.ListIndex)

RightOrValue = cboOrRight.List(cboOrRight.ListIndex)

ResultOr = LeftOrValue Or RightOrValue

txtOr.Text = ResultOr

End Sub
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jev igyk wdrïN l< ú.i And fyda Or úOdk fnd;a;ula u; la,sla lr

isÿ jk foa iy tfia jkafka wehs oehs igyka lrkak'

‘Combo Boxes’ j, jQ w.h fjkia lrñka And iy Or úOdk fnd;a;ï u;

la,sla lsÍfï § ,efnk ms<s;=re igyka lrkak'

oeka my; fla; fldgi tlalr kej; jev igyk by;ska i|yka mßÈ

l%shd;aul lr olskakg ,efnk fjkialï igyka lrkak'

Private Sub Form_Load()

cboAndLeft.ListIndex = 0

cboAndRight.ListIndex = 0

cboOrLeft.ListIndex = 0

cboOrRight.ListIndex = 0

End Sub

                   .e,Sï md,kh.e,Sï md,kh.e,Sï md,kh.e,Sï md,kh.e,Sï md,kh  (Flow Control)

l%uf,aLhl we;s m%ldY l%shd flfrk wkqms<sfj< .e,Sï md,kh (Flow

Control) f,i ye¢kafjhs' idudkH jYfhka l%uf,aLhl we;s m%ldY m<uq

m%ldYfhka wdrïN lr l%uf,aLfha olajd we;s wkqms<sfj<g wkqj l%shd;aul

flf¾' fuu wkqms<sfj< fjkia lsÍu i|yd úúO md,k jHqyhka (Control

Structures) fhdÞ .; yels h'

fuu md,k jHqyhka fhdÞ.ekSfï § wkq.ukh l< hq;= kS;suh wdlD;s fjhs'

fuu wdlD;s tu jHqyhkaf.a ldrl Í;s (Syntax) f,i ye¢kafjhs'
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                    IF....Then.....Else jHqyh'jHqyh'jHqyh'jHqyh'jHqyh'

If Condition Then

VB Statements

Else

VB Statements

End IF

.e,Sï igyk

fuu wdlD;sh i|yd fhdÞ we;s 'If', 'Then', 'Else', 'End If' hk jpk 'VB',

úfYaIs; mo fjhs'

'Condition' hkqfjka olajd we;s 'VB' m%ldYkfha wjidk m%;sM,h nQ,Sh w.hla
úh hq;= h'

'VB' Statements hkq 'VB' m%ldYhkaf.a tl;=jls'

1

2

< <

<

False
Condition

True

VB

Statement

in 2

VB

Statement

in 1

<
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fuu jHqyfha l%shdldß;ajh my; ±lafjk mßÈ ±laúh yels h'

a) 'Condition' m%ldYh iq¿ lr wjidk nQ,Sh w.h ,nd.kak'

b) fuu w.h 'True' kï 1 fldgfika olajd we;s 'VB' m%ldY tA olajd we;s

wkqms<sfj<g l%shd;aul lrkak'

c) 'Condition' m%ldYfha w.h 'False' kï 2 fldgfiys olajd we;s m%ldY tA

olajd we;s wkqms<sfj<g l%shd;aul lrkak'

Program    10   - ixLHdjla T;af;a o brÜfÜ o hkak fidhd ne,Sug

l%uf,aLhla iïmdokh lruq'

 Control Number Type Name

    1. Text Box txtNo

    2. Label lblDisplay

    3. Command Button cmdCheckNo

Private Sub cmdCheckNo_Click()

Dim No As Integer

No = Val(txtNo.Text)

If No Mod 2 = 0 Then

1

2

3
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lblDisplay.Caption = “Even Number”

Else

lblDisplay.Caption = “Odd Number”

End If

End Sub

                           1.9   Select.. Case

fuu jHqyh IF....Then.....Else jHqyhkaf.a tl;=jla f,i ±laúh yels h'

Select.. Case ys jHqyh

Select Case expression

Case Value 1

VB Statements

Case Value 2

VB Statements

...............................................

...............................................

Case Else

VB Statements

End Select

l%shdldß;ajh

'Select Case', 'Case', 'Case Else', 'End Select' fuys úfYaIs; mo fjhs'

'Expression' ys o;a; j¾.h (Data type) 'Value1', 'Value2'... o;a; j¾.hka yd tlÕ

úh hq;= h' fuys 'a' hkqfjka olajd we;s 'expression' iq¿ lr ,efnk w.h 'Value

1' iuÕ ii|d nef,a' th iudk jQ úg 1 olajd we;s fldgi l%shd flf¾' fufia

fkdjqK fyd;a tu w.h 'Value2' iuÕ o" 'Value3'.......... w.hhka iuÕ tA

1

a

2

n
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wkqms<sfj<g ii|d nef,a' lsishï 'Value' ys w.hlg 'expression' ys wjidk m%;sM,h

iudk jQ úg tu 'Value' fldgig my<ska jQ 'VB Statements' l%shd lrjkq ,nhs'

'a' ys w.h lsis u 'Value1', 'Value2', ..... w.hlg iudk fkdjqK fyd;a wjidk

'Case Else' fldgig my<ska we;s 'n' jYfhka olajd we;s fldgfiys jQ 'VB' m%ldY

l%shd;aul fjhs'

Program    11   - ixLHdjla Ok" RK fyda ìxÿj f,i fidhd .ekSu i|yd

l%uf,aLhla iïmdokh lruq'

     Control Number Type Name

    1. Label lblDisplay

    2. Command Button cmdCheckNo

Private Sub cmdCheckNo_Click()

Dim N As Single

N = InputBox(“Enter Number”)

Select Case N

Case Is < 0

lblDisplay.Caption = “Negative Number”

Case Is > 0

lblDisplay.Caption = “Positive Number”

Case Else

lblDisplay.Caption = “Zero”

End Select

End Sub

1

2
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Select .... Case ys l%shdldß;ajh ±laùu i|yd .e,Sï igykla

ks¾udKh lrkak'

                                       1'10   mqk¾lrKh1'10   mqk¾lrKh1'10   mqk¾lrKh1'10   mqk¾lrKh1'10   mqk¾lrKh (Looping)

l%uf,aLhl we;s m%ldY tl;=jla kej; kej;;a l%shd;aul lsÍu i|yd

fhdÞ.; yels jHqyhka fuu .Khg (Looping Structures) .efka'

       For ... Next      mqk¾lrKh - wdlD;shmqk¾lrKh - wdlD;shmqk¾lrKh - wdlD;shmqk¾lrKh - wdlD;shmqk¾lrKh - wdlD;sh

For  úp,Hh = wdrïNl w.h To wjidk w.h [Step wvq fyda jeä lrk w.h]

wod< fla; fldgia

Next  úp,Hh

fuys we;s [Step wvq fyda jeä lrk w.h] hk fldgi wjYH wjia:dj,

§ muKla Ndú; l< yels úl,amhls'

        For .... Next          mqk¾lrKh - l%shd;aul jk wdldrhmqk¾lrKh - l%shd;aul jk wdldrhmqk¾lrKh - l%shd;aul jk wdldrhmqk¾lrKh - l%shd;aul jk wdldrhmqk¾lrKh - l%shd;aul jk wdldrh

For ..... Next mqk¾lrKfha § uq,ska u tys i|yka lr we;s úp,Hhg wod<

w.h wdfoaY lr .ekSu isÿ lrhs' fuys § w.h wdfoaY lr .ekSu wdrïNl w.fha

isg wjidk w.h olajd ms<sfj<ska tlskatl jeä jk wdldrhg isÿ lrhs' Step

iuÕ hï w.hla ,nd § ;snqfka kï w.h folla w;r mr;rh ilia lsÍu i|yd

tu w.h Ndú; lrhs' ^tkï idudkHfhka For ..... Next mqk¾lrKfha § w.h

jeä ùu wdfrdayK ms<sfj<g tlskatl jeä jk w;r fjkia w.hj,ska w.h

jeä lsÍu fyda wvq lsÍu i|yd Step úl,amh Ndú; l< yels h'&

wjfrdayK ms<sfj<g .uka lrk mqk¾lrKhla ilia lsÍfï §

wksjd¾hfhka u fuu Step w.h Ndú; l< hq;= h'

ls%hdldrlu 1'23
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úp,Hh i|yd wdfoaY l< w.h;a iuÕska bÈßhg wefok mqk¾lrKh tys

jQ fla; fldgia l%shd;aul lrk w;r Next moh$fma<sh yuq jQ ú.i kej; jrla

For fma<sh fj; .uka lrhs' tys § wod< úp,Hfha w.h wjika w.h oehs mßlaId

lrk w;r th wjika w.h kï mqk¾lrKh wjika lrñka Next

mofhka$fma<sfhka miq j we;s fma<sh fj; jev igyk .uka lrjhs' tfia

fkdjk úg § úp,Hfha w.h wod< mßÈ fjkia fldg mqk¾lrKh ;=<g .uka

lrhs' tkï kej;;a tys jQ úOdk l%shd;aul lrñka bÈßhg .uka lrhs' Next

moh$fma<sh yuq jQ ú.i kej; jrla For fma<sh fj; .uka lrñka úp,Hfha

w.h mßlaId lsÍu isÿ lrhs' fufia fuu l%shdj úp,Hfha w.h wjika w.h jk

f;la isÿ jkq we;'

lsishï ksYaÑ; jdr .Kkla hï l%shdj,shla l%shd;aul lsÍu i|yd b;d u

myiqfjka For . ... Next mqk¾lrKh fhdod .; yels h'

WÞyrK (- my; ±lafjk l%uf,aL fldgia i,ld n,kak'

a) Sum= 0

For i= 0 to 10

Sum= Sum + i

Print i

Next

Print Sum

b) Sum= 0

For i= 0 to 10 Step 2

Sum= Sum + i

Print i

Next

Print Sum

fuys § 0 isg 10 olajd w.h tlska tl

jeäfjñka ^ms<sfj,ska& fmdarufha

my<g uqøKh jk w;r wjidkfha tu

w.hhkaj, tl;=j 55 hk w.h o

uqøKh jkq ±lsh yels h'

fuys § 0 isg 10 olajd w.h foflka

fol jeäfjñka ^tkï 0" 2" 4" 6" 8" iy

10& fmdarufha my<g uqøKh jk w;r

wjidkfha tu w.hhkaj, tl;=j 30

hk w.h o uqøKh jkq ±lsh yels h'
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c) Sum= 0

For i= 10 to 0 Step -2

Print i

Next

Do While Loop

jHqyh

Do While <condition>

       VB Statements

Loop

Do While ys ,nd § we;s fldkafoaish  (<condition>)  i;H jk wjia:dj,

È mqk¾lrKh ;=<g .uka lr tys jQ m%ldYk (b) ls%hd;aul lrhs' wÞ< fldkafoais

wi;H jQ úg mqk¾lrKfhka bj;g .uka lrhs' tkï Loop m%ldYkfhka miq j

jQ m%ldYk fj; .uka lsÍu isÿ fõ'

a

fuys § 10 isg 0 olajd w.h foflka

fol wvqfjñka ^tkï 10" 8" 6" 4" 2 iy

0& fmdarufha my<g uqøKh jkq ±lsh

yels h'

b

<

Condition

True

VB statement in

<

False

<
b
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12345678901234567890123456789012123456789012345678901234567890121
12345678901234567890123456789012123456789012345678901234567890121
12345678901234567890123456789012123456789012345678901234567890121
12345678901234567890123456789012123456789012345678901234567890121
12345678901234567890123456789012123456789012345678901234567890121

fuys 'Do While, Loop' hk jpk úfYaIs; mo fjhs' 'Condition' hk m%ldYh

nQ,Sh w.hla ,nd Èh hq;= m%ldYkhls'

kj jHdmD;shla wdrïN lr tys  Form tllg Command button

tlla tlalr tys Click event tl i|yd my; fla; we;=<;a

fldg th ls%hd;aul l< úg ,efnk m%;sM,h ksÍlaIKh lrkak'

WÞyrK

Counter= 1

Do while counter<100

Debug.Print counter

counter=counter+1

Loop

wod< Command button tl u; Click l< úg § tys m%;sM,h olajkqfha

Immediate Window tl u; h' my; ls%hdldrlïj, § we;s jk fjkia lï

ksÍlaIKh lrkak'

a.  debug.Print counter hkak Print counter hkqfjka fjkia l< úg §'

b.  debug.Print counter

counter = counter + 1 hkak counter = counter + 1

    debug.Print counter

hkqfjka fjkia l< úg §'

  1'11 wrdjka  1'11 wrdjka  1'11 wrdjka  1'11 wrdjka  1'11 wrdjka          (Arrays)

'VB' mß.Kl NdIdfõ o wksla fndfyda mß.Kl NdIdj, fuka u o;a;hka

l%uf,aLhka ;=< ;djld,sl j f.dkq l< yels l%ufõohka y÷kajd § we;' fufia

;djld,sl j l%uf,aLhla ;=< o;a; fm< .eiaùfuka idÞ.kakd o;a; jHqyhka

'Data Structures' f,i ye¢kafjhs' 'Arrays, Stacks', 'Queues' fï i|yd WÞyrK

lsysmhls'

ls%hdldrlu 1'24
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'VB' ys wrdjka (Array) hkq tl u j¾.fha o;a; iuQyhla fm<.eiaùfuka

idÞ.kakd o;a; jHqyhls' fujeks o;a; jHqyhla my; ±lafjk mßÈ oDIHlrKh

(Visualize) l< yels h'

by; o;a; jHqyh ksÅ, ixLHd myla ;djld,sl j fm<.eiaùu i|yd

ks¾udKh l< wrdjla f,i ±laúh yels h'

fujeks o;a; jHqyhla l%uf,aLhla ;=< ks¾udKh lsÍfï § uq¿ o;a;

jHqyh u ±laùu i|yd lsishï kduhla ,nd Èh hq;= h' by; WÞyrKfha § wrdjka

i|yd ,nd ÿka kduh 'Marks' hhs i,luq' bka miq tu o;a; jHqyfha tlatla

w.hka ,nd .ekSu fyda .nvdlsÍu i|yd 'Marks (Position)' hk jHqyh Ndú; l<

yels h'

fuu jHqyfha m<uq fldgiska ̂ WÞ # Marks& ku ±lafjhs' fojkq j" jryka

;=< jQ fldgiska ^WÞ # Position& wrdjkays m<uq w.hg idfmalaI j ,nd .; hq;=

w.fha ia:dkh ±lafjhs'

WodyrK #

Dim Marks (0 to 9) As Integer

by; m%ldYh u.ska 'Marks' kï jQ wrdjla ks¾udKh lr we;' fuu

wrdfjkays m<uq w.h 'Marks (0)' f,i o wjidk w.h 'Marks (9)' f,i o

ye¢kaùug wjYH nj olajd we;' tneúka fuu 'Marks' kï jQ wrdj  ;=< w.hhka

10la .nvd l< yels h'

WÞyrKla f,i ´kE u ixLHd 10l tl;=j fiùu i|yd wdrdjla u;

mokï jQ jevigykla my; ±lafjk mßÈ ks¾udKh l< yels h' fuu jevigyfka

w;=re uqyqK; my; ±lafjk f,i ilia lr we;'

4020 30 55 60

1 2 3 4 5

Marks
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       Control  Number Type Name

    1. Label lblNumbers

    2. Label lblTotal

    3. Command Button cmdTotal

Private Sub cmdTotal_Click()

Dim myNumbers(1 To 10) As Integer

Dim i As Integer

Dim total As Integer

Dim numbers As String

‘No Numbers entered yet

numbers = “”

‘ Read the 10 numbers to number array

For i = 1 To 10

myNumbers(i) = Val(InputBox(“Enterthe number “ & i))

       lblNumbers.Caption = lblNumbers.Caption & myNumbers(i) & “   ,   ”

Next i

‘Compute the total of numbers in the array

total = 0

For i = 1 To 10

total = total + myNumbers(i)

Next i

‘Display the total of numbers in the array

lblTotal.Caption = “Total of the numbers is “ & total

End Sub

3

2

1


